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Allgemeine Bedienung der Software 

2.1 Bedienung des Hauptinterfaces 

Nach dem Starten der Software können Sie das folgende Interface sehen. 

Menüleiste: Die Hauptfunktion dieser Software ist durch die Menüleiste erreichbar. 
Die Ausführung eines Menübefehls ist die einfachste Art des Betriebs. Die Menüleiste 
umfasst: 
Dokument, Überarbeiten, Zeichnen, Einstellungen, Bearbeiten, Ansicht und Hilfe. 

Systemleiste: Auf der Systemleiste befinden sich manche der am häufigsten 
benutzten Tasten. 

Grafikleiste: Auf dieser Leiste sind die Haupteigenschaften der grafischen Prozesse 
aufgelistet, u.a. Lage, Größe, Maßstab, Kalkulation. 

Menüleiste Grafikleiste Systemleiste 

Bearbeitungsleiste 
Bedienfeld 

Schichtleiste Ausrichtungsleiste 



 

Bearbeitungsleiste : Die Bearbeitungsleiste befindet sich standardgemäß auf der 
linken Seite des Arbeitsbereichs. Auf der Bearbeitungsleiste sind oft benutzte 
Werkzeuge aufgelistet, damit die Bedienung flexibler und bequemer ist. 

Ausrichtungsleiste : Ausrichtung ausgewählter Objekte, 
Schichtleiste: Wechsel der Schicht ausgewählter Objekte, 

Bedienfeld : Das Bedienfeld dient zur Ausführung der Laserbearbeitung mehrerer 
Aufgaben, Einstellung der Schichtparameter, Achsensteuerung, Bearbeitung usw. 

2.2 Spracheinstellungen und Herstellerinformationen 

Die Systemsprache wird bei der Installierung gewählt. Danach kann die Sprache auch 
leicht geändert werden. 

Klicken Sie auf die Menüleiste [Help] -> /Language] (Hilfe > Sprache) und wählen 
Sie entsprechend aus dem Aufklappmenü  
language Arten. 

 

Um Herstellerinformationen zu erhalten, damit die Qualität unserer Dienstleistungen 
erhöht werden kann, klicken Sie auf Menüleiste [Help] -> [About RDCAM] (Hilfe > Über...) 

 

Wie man die Hersteller-bezogenen Daten einstellt, erfahren Sie in (RDCAM 
Software-Installationsanleitung) 

Unten im Dialogfenster sieht man die aktuelle Versionsnummer der Software. Da bei 
verschiedenen Software-Versionen Unterschiede im Bereich der Funktionen und der 
Interfaces vorkommen können, ist es empfehlenswert, die Versionsnummer der Software 
in Kontakten mit dem Hersteller zu benutzen. 

 



 

2.3 Seiteneinstellungen 

Klicken Sie auf die Menüleiste [Config] -> [Page Setting] (Konfig > Seiteneinstellung) 
und das folgende Dialogfenster erscheint: 

 

[Page Breite] (Seitenbreite): die Breite der Softwareseite, die normalerweise der X-Breite 
der Maschine entspricht 

[Page Höhe] (Seitenhöhe): die Höhe der Softwareseite, die normalerweise der Y-Breite 
der Maschine entspricht  

Unter normalen Bedingungen, wenn Sie an die Hauptplatine angeschlossen sind, 
formatiert sich die Software automatisch gemäß den aktuellen Arbeitsvorgang der 
Maschine als Seitengröße. 

Ist die Hauptplatine nicht angeschlossen, oder braucht sie ihre eigene Sondergröße 
der Seite (damit die Seitengröße dem Material entspricht), können die Seiteneinstellungen 
benutzen, um die Seitengröße anzupassen. 
2.4 Öffnen und Speichern der Datei 

Die Software benutzt das rld-Dateiformat, um grafische Informationen zu speichern, z.B. 
Schichtparameter unterschiedlicher Schichten und die Abfolge der Bearbeitung grafischer 
Elemente. 

2.4.1 Öffnen der Datei 

(1) Klicken Sie auf das Menü [File] -> [Open] (Datei > Öffnen), oder klicken Sie auf 
das Icon , und das folgende Dialogfenster erscheint: 

Datei wählen  



 

(2) Wählen Sie eine Datei (z.B. Default.rld) und klicken Sie auf [Open] (Öffnen) 

2.4.2 Speichern der Datei 

( 1 ) Klicken Sie auf das Menü [ File ] -> [ Save ] (Datei > Speichern), oder klicken 
Sie auf das Icon , und das folgende Dialogfenster erscheint : 

(2) Geben Sie den Dateinamen in der Zeile ein und klicken Sie auf [Save]. 

2.5 Dateiimport und -export 
Da diese Software in rid-Format ist, wird das Herstellen oder Bearbeitung anderer 

Materialien durch Importieren ermöglicht. Entsprechend können grafische Dateien in eine 
andere Software exportiert werden. 

Die unterstützten Dateiformate für Import: dxf, ai, plt, dst, dsb, usw. 
Das unterstützte Dateiformat für Export: plt 

2.5.1 Dateiimport 

Klicken Sie auf das Menü [ File ] -> [ Import ] (Datei > Import), oder klicken Sie auf 

das Icon . Es erscheint das folgende Dialogfenster. 
Wählen Sie eine Datei und klicken Sie auf [Open] (Öffnen) 

Dateiname eingeben 



 

 

♦ Wählen Sie [Preview] (Vorschau), damit die gewählte Datei gezeigt wird. 
Für die meisten Vektor-Dateien werden die Daten automatisch in die entsprechende 

Schicht der RDCAM-Software, gemäß der Schichtbeschreibung importiert. 
Bei manchen Dokumenten wie DST/DSB werden die Daten in die aktuelle Schicht 

importiert. 

 

Aktuelle Schicht 



 

2.5.2 Dateiexport 

Klicken Sie auf das Menü [File] -> [Export] (Datei > Export) oder klicken Sie auf 

das Icon Es erscheint das Export-Dialogfenster. Geben Sie den Dateinamen 

ein, und klicken Sie auf [Save] (Speichern). 

3.5.3 Einstellung der Dateiparameter 

♦ PLT Precision (PLT-Präzision): Um das richtige Element gemäß der Genauigkeit 
der originalen plt-Datei zu importieren. 

♦ Smooth curves (Glättung der Kurven): Beim Importieren einer Vektor-Datei, 
werden die originalen Kurven automatisch geglättet. Wenn die originale Grafik 
glatt ist oder wenn der Glättungseffekt immer wieder eingestellt werden müsste, 
können Sie diese Taste abwählen. Wenn die Glättung nicht gewählt wird, kann 
das die Importdauer verkürzen. 

♦ Auto close curves (automatisches Schließen der Kurven): Automatisches 
Überprüfen und Schließen von Kurven gemäß der Schließtoleranz 

♦ Combine Linien (Linien verbinden): Automatisches Verbinden von Linien gemäß 
Verbindungstoleranz. 

♦ Color map automatic switch to grayscale (automatisches Umschalten von der 
Farbkarte auf Graumaßstab): Unter normalen Bedingungen basiert die Grafik auf 
Graumaßstab. Wenn die importierte Bitmap ein farbiges Bild ist, kann es zum 
Graumaßstab konvertiert werden. 

♦ Import Dxf text message (Dxf Textnachricht importieren): Wenn der Benutzer 
bei Dxf nur die Grafik braucht und nicht den Text in der Datei, soll diese Option 
nicht markiert werden. 

♦ Export precision (Exportpräzision): Die Exportpräzision bei einer plt-Datei oder 
einer Ausgangsdatei. 

♦ Velocity unit (Geschwindigkeitseinheit): Die Software unterstützt zwei Arten von 
Geschwindigkeitseinheiten: mm/s, m/min. Sie sind entsprechend zu wählen. Nach 
der Wahl werden sich die Geschwindigkeitsparameter auf dem Interface 
entsprechend ändern. 



 

2.6 Erstellung der Hauptgrafik 

 ♦ Line 

Klicken Sie auf das Menü [ Draw ] -> [ Line ] (Zeichnen > Linie), oder klicken Sie auf  auf 

der Bearbeitungsleiste, und ziehen Sie mit der Maus auf dem Bildschirm. Sie können so eine 

Linie zeichnen. Drücken Sie “Ctrl”, wenn Sie mit der Maus ziehen, um eine horizontale oder 

vertikale Linie zu zeichnen. 

♦ Polylinie 

Klicken Sie auf das Menü [Draw] -> [Polylinie] (Zeichen > Polylinie), oder klicken Sie 

auf  auf der Bearbeitungsleiste und ziehen Sie mit der Maus auf dem 

Bildschirm. Sie können so eine Polylinie zeichnen. 

♦ Rechteck 
Klicken Sie auf das Menü [Draw] -> [Rechteck] (Zeichnen > Rechteck), oder klicken 

Sie auf  auf der Bearbeitungsleiste und ziehen Sie mit der Maus auf 
dem Bildschirm. Sie können so ein beliebiges Rechteck zeichnen. 

Drücken Sie “Ctrl”, wenn Sie mit der Maus ziehen, um einen Quadrat zu zeichnen. 

 



 

♦ Ellipse 

Klicken Sie auf das Menü [Draw] -> [Ellipse] (Zeichnen > Ellipse), oder klicken Sie 

auf  auf der Bearbeitungsleiste und ziehen Sie mit der Maus auf dem 

Bildschirm. 
Sie können so eine beliebige Ellipse zeichnen. 
Drücken Sie “Ctrl”, wenn Sie mit der Maus ziehen, um einen Kreis zu zeichnen. 

♦ Punkt 

Klicken Sie auf das Menü [Draw] -> [Ellipse], oder klicken Sie  auf der 

Bearbeitungsleiste. Klicken Sie mit der Maus auf dem Bildschirm. Sie können so 

einen Punkt zeichnen. 

♦ Text 

Klicken Sie auf das Menü [Draw] -> [Text] (Zeichnen > Text), oder klicken Sie  auf der 

Bearbeitungsleiste. 

Die Software unterstützt zwei Schriftarten beim Textschreiben: TrueType und SHX. 

 

Klicken Sie zweimal auf dem Bildschirm und es erscheint das folgende Dialogfenster. 

 

Geben Sie die Schriftgröße und Texteinstellung ein und 
klicken Sie auf [ O K ]   

 Erfassen 
Klicken Sie auf das Menü [Draw] -> [Capture] (Zeichnen > 

Erfassen), oder klicken Sie auf der Bearbeitungsleiste 
 



 

Wenn der Computer an ein Bildgerät angeschlossen wurde, erscheint das obige 
Dialogfenster. Nach der Wahl des Geräts können Sie die Bilder aus diesem Gerät 
herunterladen. 

2.7 Wählen des Objekts 

Beim Zeichnen und Bearbeitung der Grafik, muss zuerst ein Objekt gewählt werden. 
Das gewählte Objekt wird ein " x ” in der Mitte und acht Kontrollpunkte um sich herum 
haben. 

Klicken Sie auf das Menü [ Draw ] -> [ Select ] (Zeichnen > Wählen), oder klicken 
Sie  auf der Bearbeitungsleiste, um in den 

Wahlmodus umzuschalten. Dann können Sie ein Objekt wählen. Es gibt fünf 
Wahlverfahren : 

♦ Klicken Sie auf das Menü [Edit] -> [Select All] (Überarbeiten > Alle wählen) 
(Tastaturkürzel Ctrl+A) , um alle Objekte zu wählen, 

♦ Klicken Sie mit der Maus auf dem Bildschirm, um ein Objekt zu wählen. 

 

♦ Wählen Sie ein Objekt mithilfe des Kontrollkästchens. 

Drücken Sie Maus und ziehen Sie, bis das Kästchen mit dem Objekt in Kontakt 
kommt, dann wird es gewählt, 

♦ Objekt plus/Objekt minus 

Objekt plus: Drücken Sie “Shift”, klicken Sie oder markieren Sie das Kästchen, um das 
Objekt zu vergrößern. 
Objekt minus: Drücken Sie “Shift”, klicken Sie oder markieren Sie das Kästchen, um 
das Objekt zu verkleinern. 

 



 

+ Wählen Sie das Objekt je nach der Schicht 

Rechtsklicken Sie auf die gewählte Schicht, um ein Teil aller Objekte in der Schicht zu wählen. 

2.8 Objektfarbe 

Die Farbe des Objekts ist die Farbe seines Umrisses. Sie können auf die Farbtaste auf 
der Schichtleiste klicken, um die Farbe des Objekts zu wählen. Die Farbe der gedrückten 
Taste ist die Farbe der aktuellen Schicht. 

2.9 Umgestaltung des Objects 
Die Umgestaltung des Objekts umfasst vor allem: Lage des Objekts, Orientierung und 

Größe. Aber sie ändert die grundsätzliche Form des Objekts und seine Eigenschaften 
nicht. 

Die Umgestaltung des Objekts für Benutzer hat ein bequemes Interface. Der Benutzer 

kann das Objekt durch widerspiegeln und rotieren. 

Sie können auch die Eigenschaftsleiste des Objekts benutzen 

Sie können auch entsprechende Werkzeuge benutzen, um die Grafik zu umwandeln 
und zu kopieren. 

 

 

 

 



 

 

2.9.1 Abbildung des Objekts 

Die Abbildung des Objekts ist das Kippen des gewählten Objekts horizontal 

oder vertikal. Klicken Sie auf  auf der Bearbeitungsleiste und das 

gewählte Objekt wird horizontal gekippt. 

Klicken Sie auf  auf der Bearbeitungsleiste und das gewählte Objekt wird 
horizontal gekippt. 



 

 

Sie können auch das Objekt horizontal und vertikal widerspiegeln und kopieren, indem Sie  
Werkzeuge zur Umwandlung benutzen. 

2.9.2 Umdrehen des Objekts 
Klicken Sie auf  auf der Bearbeitungsleiste und es erscheint ein Dialogfenster zur 
Einstellung des Rotationswinkels. 

Stellen Sie den Rotationswinkel ein und klicken Sie auf [OK]. 

 

Wenn Sie die Rotation durch Ziehen machen wollen, stellen Sie zuerst den 
Rotationswinkel auf 0 ein. 

Ziehen Sie mit der Maus, um den Rotationswinkel anzupassen, wobei Sie den Umriss 
rotieren sehen. 



 

 

 

Oder Sie benutzen die Rotationswerkzeuge, um diese Umwandlung des Objekts 
durchzuführen. Dort können Sie den Drehpunkt einstellen und festhalten. 

2.9.3 Objektgröße 

Sie können die Größe und die zentrale Lage des gewählten Objekts einstellen. 

Oder Sie geben den Rotationswinkel direkt auf der Eigenschaftsleiste des Objekts ein. 

 



 

 

Oder benutzen Sie die Umwandlungsleiste, um die Größe des Objekts zu ändern. Sie 
können die Größe ändern, Seitenverhältnis feststellen, und die Lage im Verhältnis zum 
umzuwandelnden Objekt einstellen. 



 

 

Das Objekt kann mithilfe der entsprechenden Umwandlungswerkzeuge gekippt 
werden. Man kann den Kippanker und den Kippwinkel einstellen. 

Durch das Kippen wird die Bitmap verzerrt und ihre praktische Anwendung ist gering, 
zurzeit wird nur das Kippen der Vektorgrafik unterstützt. 

2.9.5 Matrix-Wiederholung des Objekts 

Klicken Sie auf  auf der Bearbeitungsleiste und wählen Sie das Objekt aus, das Sie 

kopieren wollen. Dann klicken Sie auf , und das folgende Dialogfenster erscheint: 



 

Breite einer einzelnen Grafik (mm) 

Sie können das Objekt als Matrix in verschiedenen Richtungen kopieren. Die Richtung 
des Kopierens basiert auf der originalen Grafik. Wenn z.B. die Matrix-Richtung rechts unten 
gewählt wird, erscheint die originale Grafik in der linken oberen Ecke und wenn die 
Matrix-Richtung als links oben gewählt wird, erscheint die originale Grafik rechts unten. 

Nach der Einstellung der Anzahl und des Abstands der Reihen, klicken Sie auf 
[Apply] (Anwenden). Sie können die Grafik-Matrix sehen. 

Es gibt zwei Formen des Abstands in der Matrix: Zentralabstand und Randabstand. 
Wählen Sie den Zentralabstand, dann ist [ X Distance(mm) ] [ Y Distance(mm)] der 
Abstand zwischen den Mittelpunkten der zwei Grafiken. 
Wenn Sie nicht Zentralabstand wählen, dann ist [ X Distance(mm) ] [ Y 
Distance(mm)] der Abstand zwischen den Rändern der zwei Grafiken. 
Zentralabstand X = Randabstand X + Objektbreite 
Zentralabstand Y = Randabstand Y + Objekthöhe 
Schalten Sie zwischen den zwei Berechnungsverfahren um, [X Distance(mm) ] , [Y 

Distance(mm)] werden automatisch berechnet. 
Klicken Sie auf [ Bestrewing breadth ] (Streubreite), und die Software berechnet 
automatisch die Anzahl der Reihen in der Matrix 

je nach der Größe, Breite, Höhe, X Abstand und Y Abstand des Werkstücks. 
Sie können den Abstand regeln, indem Sie entsprechende Werte direkt eingeben, und 
dann klicken Sie auf [Apply] (Anwenden). 

 

  

Höhe einer einzelnen Grafik (mm) 



 

Sie können auch die Richtungstasten drücken, um die Abstände der Objekte zu 
regeln. 

Markieren Sie [Center] (Mitte), dann, nach der Wiederholung des Objekts als Matrix, 
befindet sich die Grafik in der Mitte des Arbeitsbereichs. 

Scrollen Sie das Mausrad, um die Grafik zu zoomen. 
Ziehen Sie mit der Maus, um die Grafik mitzuziehen, 

 

2.9.6 Schieben des Objekts zum Ausgangspunkt 

Das Schieben des Objekts erleichtert das Anschauen oder Orientierung. Die Software 
bietet die folgenden Werkzeuge: 

, das gewählte Objekt wird in der Mitte der Seite platziert, d.h. die Mitte des Objekts ist 

auch die Mitte der Seite. 

, das gewählte Objekt wird auf der Seite, in der Ecke links, rechts oben, 

rechts unten, links unten platziert, sodass die entsprechende Ecke der Seite und des 

Objekts aufeinander liegen. 

2.10 Ausrichtung des Objekts 

Wählen Sie Objekte, klicken Sie auf Werkzeuge auf der Ausrichtungsleiste. 



 

Bezugsobjekt : 
Wenn Sie “Shift” drücken und ein Objekt nach dem anderen wählen, ist das letzte Objekt 
das Bezugsobjekt. 
Wenn Sie das Objekt mithilfe des Kontrollkästchens wählen, ist das Bezugsobjekt das 
Objekt mit der letzten Kurvennummer. 

2.11 Objektansicht 

♦ Move (Bewegen): Klicken Sie auf das Menü [Edit] -> [Move], oder klicken Sie auf

Dann halten Sie die linke Maustaste auf der Zeichenfläche gedrückt, und 
ziehen Sie. 

♦ Zoom Out (Verkleinern): Klicken Sie auf das Menü [ Edit ] -> [ ZoomOut ], oder 

klicken Sie auf Bei jedem Klick wird das Bereich einmal verkleinert. Bewegen Sie 
die Maus auf die Zeichenfläche und klicken Sie. Bei jedem Klick wird der Bereich um 
den geklickten Punkt einmal verkleinert. 
♦ Zoom In (Vergrößern): Klicken Sie auf das Menü [Edit] -> [Zoomln] , oder klicken 

Sie auf  Bei jedem Klick wird die Zeichenfläche einmal vergrößert. Bewegen Sie 
die Maus auf die Zeichenfläche und klicken Sie. Bei jedem Klick wird der Bereich um 
den geklickten Punkt einmal vergrößert. 

♦ View Select (Ansicht wählen): Klicken Sie auf das Menü [Edit] -> [View select], 

oder klicken Sie auf Bewegen Sie die Maus auf die Zeichenfläche, halten Sie die 
linke Maustaste gedrückt und ziehen Sie. Ein Bereich der der Zeichenfläche wird mit 
der Strichlinie markiert. Lassen Sie die Maustaste los, dann wird der markierte Bereich  
vergrößert dargestellt. 

♦ View Page Frame (Seitenrahmen zeigen): Klicken Sie auf das Menü [Edit] -> 
[View Page Frame], oder klicken Sie auf . Der Seitenrahmen wird voll 
dargestellt. 

♦ View Data Frame (Datenrahmen zeigen): Klicken Sie auf das Menü [Edit] -> 
[View Data Frame], oder klicken Sie auf  . Das gewählte Objekt wird voll 
dargestellt. 

 

Diese umfasst: 

Linke Ausrichtung. Rechte Ausrichtung. Obere Ausrichtung, Untere Ausrichtung 

Ausrichtung des vertikalen Mittelpunkts, Ausrichtung des horizontalen 
Mittelpunkts, Ausrichtung des Mittelpunkts 

Horizontale Äquidistanz. Vertikale Äquidistanz 

Gleiche Breite. gleiche Höhe, gleiche Größe. 

 

 

 

 



2.12 Gruppieren und Entgruppieren 
Die bearbeitete Grafik muss manchmal ein Teil eines Vorgangs als Ganzes sein (z.B. 
Layout eines Textes mit mehreren Zeilen). 

Verfahren: Wählen Sie eine Gruppe von Grafiken, und dann wählen Sie das Menü [ 

Edit ]([Group]) ( [UnGroup] ), oder wählen Sie direkt aus der Werkzeugleiste. 



 

2.13 Wichtige Werkzeuge 

Hier sind ein paar oft benutzte Werkzeuge. Wenn Sie diese Werkzeuge benutzen, 
kann die Grafik im aktuellen Dokument ordentlicher gemacht werden, und die 
Ausgabe wird schneller bearbeitet. 

2.13.1 Manuelles Sortieren, Einstellung des Schnittpunktes und der Schnittrichtung 

Die Software ist ein bequemes Werkzeug zur manuellen Sortierung. Wählen Sie [Edit] - 
> [ Set cutting property ] (Schnitteigenschaften einstellen). Es erscheint das 
Schnitteigenschaften-Dialogfenster. Hier können Sie die ganze manuelle Sortierung, Schnittpunkte und 
Schnittrichtung einstellen. 

1> Weg zeigen 
Zuerst markieren Sie “Weg zeigen”, hier werden die Schnittanordnung und die 
Schnittrichtung in der aktuellen Grafik gezeigt. 

 

 



 

4> Änderung des Schnittpunktes 

 

Wählen Sie die Grafik, bei der der Schnittpunkt zu ändern ist, es werden alle Knoten 
auf der aktuellen Grafik gezeigt. Wählen Sie den Ausgangspunkt, doppelklicken Sie und der 
Ausgangspunkt der aktuellen Grafik wird geändert. Nach allen Änderungen, klicken Sie auf 

, um das Ergebnis zu speichern. 

Außer der Änderung der Schnitteigenschaften, bietet die Software auch Werkzeuge zur 
Änderung der Abfolge des Schneidevorgangs, der Schnittrichtung und des Schnittpunktes. 

2> Manuelles Sortieren 

Wählen Sie Diese Taste dient zur Umschaltung zwischen  Bearbeitung und Ansicht. 

Dann können Sie die Grafik auf dem grafischen Anzeigebereich markieren oder anklicken 

(klicken Sie auf 

ein Pixel oder markieren Sie mehrere Pixel). Nach der Wahl der Grafik wählen Sie so 

wird die Grafik 
in eine andere Liste übertragen, wo sie in erster Linie bearbeitet wird. Wiederholen Sie das 
mit den anderen Grafiken, damit alle Grafiken wie gewünscht angeordnet werden. 

3> Wechsel der Richtung der Grafikbearbeitung 
Wählen Sie die Grafik auf dem grafischen Anzeigebereich oder auf der Liste und dann 

klicken Sie auf 
 

 

 



 

Wählen Sie 
 

auf der Werkzeugliste, oder klicken Sie auf das Menübefehl 
[Edit] -> [Show Path] (Weg zeigen). 

 

1> Manuelles Sortieren 
Wählen Sie die Vorlage, die in der Abfolge des Schneidevorgangs geändert werden 

soll, dann erscheint die Seriennummer der Vorlage auf der Leiste der Objekteigenschaften. 

 

Geben Sie die Seriennummer direkt als Bearbeitungsnummer ein, dann drücken Sie 
“Enter” auf der Tastatur, oder klicken Sie auf die Zeichenfläche und die Abfolge wird 
geändert. 
2> Änderung der Bearbeitungsrichtung 

Klicken Sie auf [Edit] -> [Set cut Richtung] (Schnittrichtung einstellen), um die 
Edition der Schnittrichtung zu starten. 



 

Dann doppelklicken Sie eine beliebige Stelle der gewählten Grafik. 

3> Wechsel des Schnittpunktes 
Klicken Sie auf [Edit] -> [Set cut point] (Schnittpunkt einstellen), um den Schnittpunkt  

edieren zu können. Dann wählen Sie die zu ändernde Kurve, doppelklicken Sie auf den 
Knoten, wo Sie den Schnittpunkt setzen wollen, um den Wechsel abzuschließen. 

2.13.2 Einstellen und Edieren der Einschnitt-/Ausschnittlinien 

Wenn Kurven gezeichnet oder importiert werden, haben sie standardmäßig keine 
Einschnitt-/Ausschnittlinien. 

Wenn Sie Einschnitt-/Ausschnittlinien hinzufügen wollen, wählen Sie Objekte, dann 
klicken Sie auf [Edit] -> [Edit cutin property] (Schnitteigenschaft edieren), oder klicken 
Sie auf Es erscheint das folgende Dialogfenster. 

 

Um Einschnitt-/Ausschnittlinien hinzufügen, müssen Sie zuerst die 
Einschnitt-/Ausschnitt-Funktion einschalten. Es gibt zwei Arten der 
Einschnitt-/Ausschnittlinien: eine gerade Linie und ein Bogen. 

Es gibt drei Möglichkeiten, eine gerade Linie zu machen: 
a) Einschneiden im Winkel: eine Linie schneiden und ein Segment in einem 

Winkel beginnen, ein Winkel im Gegenuhrzeigersinn ist positiv 
b)  Einschneiden in der Mitte, der Ausgangspunkt der Einschnittlinie ist in der 

Mitte. 
c)  Einschneiden aus der Mitte, die Schnittrichtung des gradlinigen Schnitts ist 

aus der Mitte zum Ausgangspunkt, und die Länge ist wie eingestellt. 



 

Einschnittlinie 

Einschnittlinie 

Die Länge der bogenförmigen Einschnittlinie ist wie eingestellt. 
Es gibt zwei Arten von Einschnitt-/Ausschnittbögen, wie auf dem folgenden Bild 

 

Weiblich 

 

Die Einstellung der Ausschnittlinien erfolgt genauso wie bei Einschnittlinien. 

2.13.3 Optimierung des Weges 

Die Optimierung des Weges ist in erster Linie eine Neuanordnung der Vektorgrafik. 

Klicken Sie auf das Menü [Handle] -> [Cut optimize] (Schnitt optimieren), oder 

klicken Sie auf , und das folgende Dialogfenster erscheint. 

 

Männlich 



 

Klicken Sie auf das Menü [Edit] -> [Show Path] (Weg zeigen), oder klicken Sie auf ,       
und der Schnittweg vor und nach der Bearbeitung wird gezeigt. 

 

Vor der Bearbeitung Nach der Bearbeitung 

Der Schnittweg startet immer vom Laserkopf. 

2.13.4 Glätten der Kurven 

Diese Funktion kann die weniger genauen Kurven etwas glätten, damit sie auch glatter 
bearbeitet werden können. 

Klicken Sie auf das Menü [ Handle ] -> [ Curve Smooth ] (Kurven glätten), oder klicken 

Sie auf , und das folgende Dialogfenster erscheint. 

 Laserkopf 



 

 

Ziehen Sie den Glätte-Schieberegler, und klicken Sie auf [Apply] (Anwenden), die 
Kurven vor der Glättung und danach werden alle im Dialogfenster dargestellt. 

Die schwarzen Kurven sind die originalen Kurven und die geglätteten Kurven sind rot. 



 

Sie können sich die Grafik anschauen, indem Sie mit der Maus ziehen. 
Sie können die Grafik mit dem Scrollrad vergrößern/verkleinern. 
Klicken Sie auf [FullFrame] und die Grafik erscheint Dialogfenster in voller Größe. 
Wenn Sie mit dem Glättungseffekt, klicken Sie auf [Apply] (Anwenden) und die Kurven 

werden gemäß der Einstellungen geglättet. 
Wählen Sie “Direct smooth” (direkte Glättung) und Sie können ein anderes 
Glättungsverfahren anwenden. 
Die Glättungsverfahren sollen der einzelnen Grafiken angepasst werden. 

2.13.5 Schließen der Kurve 

Klicken Sie auf das Menü [ Handle ] -> [ Curve auto close ] (Kurve automatisch 

schließen), oder klicken Sie auf  auf der Systemleiste und das folgende Dialogfenster 

erscheint. 



 

Schlussfehler: Wenn der Abstand vom Ausgangspunkt zum Endpunkt weniger als die 
Schlusstoleranz beträgt, wird die Kurve automatisch geschlossen. 
Gezwungenes Schließen: zwingendes Schließen aller gewählten Kurven. 

2.13.6 Beseitigung der Überlappung 

Klicken Sie auf das Menü [Handle] -> [Delete overlap] (Überlappung entfernen), oder 
klicken Sie auf  und das folgende Dialogfenster erscheint. 

 

Unter normalen Bedingungen wählen Sie nicht “Enable Overlap error” 
(Überlappungsfehler zulassen). Entfernen der überlappenden Linien, wenn  zwei Linien im 
großen Maße überlappen. Wenn Sie die überlappenden Linien entfernen müssen, wählen 
Sie “Enable Overlap error”, und stellen Sie den Wert des Fehlers ein. Im Allgemeinen 
stellen Sie den Überlappungsfehler nicht zu hoch, um eine zufällige Löschung zu 
vermeiden. 

2.13.7 Verbinden der Kurven 

Klicken Sie auf das Menü [Handle] / [Combine Curve] (Kurven verbinden), oder klicken 

Sie auf und das folgende Dialogfenster erscheint. 

 

 



 

Die Software verbindet automatisch die gewählten Kurven, wenn die Verbindungstoleranz 
dieser Kurven weniger als der Einstellwert des Verbindungsfehlers (combine error) ist. 

2.13.8 Bearbeiten der Bitmap 

Klicken Sie auf  und wählen Sie eine Bitmap, dann klicken Sie auf Menü [Handle] -> 
[Bitmap handle] (Bitmap bearbeiten), 

oder klicken Sie  auf der Systemleiste. 

 

Rechts oben im Dialogfenster wird die Information über das aktuelle Bild gezeigt. 
Beachten Sie, dass die horizontale und vertikale Auflösung sich ändern, wenn Sie den 

Maßstab durch Ziehen ändern. 

[Apply to view] (auf Ansicht anwenden): Die aktuellen Einstellungen gelten nur für 
die Vorschau und beeinflussen nicht die originale Bitmap, drücken Sie [Cancel] 
(Abbrechen) und der Originalzustand der Bitmap wird wiederhergestellt. Benutzen Sie es 
nur zur Anpassung. Der Nachteil: Es beansprucht mehr Zeit und Speicherkapazität. 

[Apply to source] (auf Quelle anwenden): Die aktuellen Einstellungen werden 
direkt auf die originale Bitmap angewendet, also selbst wenn Sie am Ende auf [Cancel] 
klicken, wird der ursprüngliche Zustand des Bildes nicht wiederhergestellt. 
So wird es vor allem in der mehrstufigen Bearbeitung angewendet, wo die aktuelle 
Bearbeitung erforderlich ist, wenn Bilder z.B. in Graustufenbilder umgewandelt werden 
müssen. Das erspart die Zeit der Nachbearbeitung. 



 

[ Save as ] (Speichern als): Speichern Sie die Ergebnisse der früheren 
Bearbeitung. Die Grafik kann nach 
 [Apply to view] (auf Ansicht anwenden) auch exportiert werden. Damit wird die 
Nachbearbeitung erleichtert. 

[ Gray scale ] (Graumaßstab) Eine andere Art von Bildbearbeitung basiert auf dem 
Graumaßstab, wo ein Bild vor der eigentlichen Bearbeitung in ein Graustufenbild 
umgewandelt wird. Sie können also ein Graustufenbild machen, dann klicken Sie auf [ 
Apply to source ] (auf Quelle anwenden). Das Graustufenbild braucht weniger 
Speicherplatz als ein Farbbild, wobei große Bilder stufenweise bearbeitet werden sollen, 
damit genug Speicherkapazität übrig bleibt. 

Bei Farbbildern regeln Sie Kontrast und Helligkeit, fügen Sie einen zusätzlichen Effekt 
für das Dithering hinzu. 

Adjust contrast: 

Vor der Bearbeitung Nach der Bearbeitung 
Farbumkehrung: 

 

Vor der Bearbeitung 

 

Nach der Bearbeitung 
Schärfe: 



 

  

Vor der Bearbeitung Nach der Bearbeitung 

Es gibt drei Ditheringverfahren: Netzgrafik, Punktgrafik, Schwarzweiß 

1> Netzgrafik 
Bei der Netzgrafik muss die Netzgröße eingestellt werden, damit sie besser an das 

Material mit geringerer Auflösung angepasst wird, oder wenn der Laser langsam reagiert. 
Um die richtige Netzgröße einzustellen, können Sie die Auflösung und die 

Netzfrequenz des Bildes regeln. 
Je höher die Auflösung, desto feiner soll die Einstellung sein. 
Je höher die Netzfrequenz, desto niedriger die Netzgröße. Je niedriger Netzfrequenz, 

desto höher die Netzgröße. 
Im Allgemeinen beträgt die Auflösung eines Bildes 500 - 1000 und die Netzfrequenz 

30-40 Zeilen. 

  



 

2> Punktgrafik 
Punktgrafik als Herstellen eines guten Graustufenbildes, besser geeignet für ein 

Material von hoher Auflösung und wenn der Laser schnell reagiert. 

 

3> Schwarzweiß 
In den meisten Fällen ist der Effekt der Umwandlung eines Farbbildes in ein 

Schwarzweißbild eher ungünstig, doch wenn der Umriss klar ist, kann das Verfahren 
angewendet werden. 

 



 

Umriss bekommen: 

 

Klicken Sie auf “Get outline”, um den Umriss der Grafik wie auf dem Bild unten zu entnehmen  

 

2.13.9 Bearbeitung der Vorschau 

 

Klicken Sie auf das Menü [Edit] -> [Preview], oder klicken Sie      auf der Systemleiste 



 

 

Die Software unterstützt die Vorschau der zu bearbeitenden Dokumente und so 
können Sie bestimmte grundsätzliche Information der Vorschau entnehmen, z.B., den Weg 
aus der aktuellen Ausgabe der Bearbeitung, die allgemeine Bearbeitungsdauer, Abstand 
bei der Bearbeitung. Der Bearbeitungsvorgang kann simuliert werden. 

Außer der Vorschau der aktuell bearbeiteten Datei können Sie sich auch die 
gespeicherten rd-Dateien anschauen. 

1 > Vorschau der rd-Dateien: 
Klicken Sie zweimal auf dem grafischen Anzeigebereich. Wählen Sie die Grafik, die 

Sie in einem Dialogfenster sich anschauen wollen und dann öffnen Sie sie. 

 



 

2> Mit der Software können auch die Vorschauparameter eingestellt werden 
Rechtsklicken Sie beliebig auf dem grafischen Anzeigebereich und das 

Konfigurationsmenü erscheint. 
Wählen sie “Config” und das folgende Dialogfenster erscheint 

Vollfenster  

Konfig 

Horizontaler Spiegel  

Vertikaler Spiegel 

 

Sie können die Farbe der Grafik vorher betrachten, um der tatsächlichen 
Ausgangsintensität anzupassen. Die Benutzer können leicht sehen, ob die Intensität der 
Schicht wirklich ist. 



 

Kapitel 3 Systemeinstellungen 
Vor der Wiedergabe der Grafik ist es erforderlich, festzustellen, ob die Systemeinstellungen 

korrekt sind. Klicken Sie das Menü [Config] -> [System Setting] 

3.1 Allgemeine Einstellungen 

1> Achsenspiegel 
Im Allgemeinen, basiert die Achsenrichtung des Spiegels auf der tatsächlichen Lage  

der Grenze oder des Ausgangspunktes der Maschine. 
Das standardgemäße Koordinatensystem ist kartesisches Koordinatensystem mit 

Null unten links. 

 

 



Wenn der Nullpunkt der Maschine oben links ist, dann braucht die X-Achse nicht 
widerspiegelt zu werden, aber die Y- Achse schon. 

Wenn der Nullpunkt der Maschine oben rechts ist, dann müssen die X-Achse und 
Y-Achse widerspiegelt werden. 

Sie können diese Spiegel-Funktion auch für andere Zwecke verwenden. 

2> Laserkopf 
Die Lage des Laserkopfes bedeutet die Lage des Laserkopfes im Verhältnis zur Grafik. 

  
 

Links oben Mitte oben Rechts oben 

 



 

 

 
 

  

Mitte unten Rechts unten 

Wenn Sie intuitive Ansicht benutzen, suchen Sie einfach den Bereich mit einem grünen Punkt. 

 

3> Absolute Koordinate 
Sie können diese Option direkt wählen, wenn Sie wollen, dass die Position der Grafik 

auf dem grafischen Anzeigebereich mit der wirklichen Position des Werkzeugs bei der 
Bearbeitung übereinstimmt. Dann entspricht die Position der Grafik nicht mehr dem 
wirklichen Ausgangspunkt des Laserkopfes und dem Orientierungspunkt, sondern dem 
mechanischen Ausgangspunkt als Ankerpunkt. 

Mitte links Mitte Mitte rechts 

Links unten 



 

4> Geschwindigkeitsbegrenzung beim kleinen Kreis 
Bei der Bearbeitung eines Werkstücks stellt die Software automatisch fest, ob der 

aktuelle Kreis einer Geschwindigkeitsbegrenzung bedarf. Dann, je nach dem Durchmesser 
des Kreises wird die Geschwindigkeit festgestellt. Wenn die Konfiguration der Parameter 
richtig ist, wird die Qualität der kleinen Kreise erheblich verbessert. Klicken Sie auf [Add] , 
[Delete] , [Modify] (Erhöhen, Löschen, Ändern) um entsprechend zu konfigurieren. 

Ein kleiner Kreis bedarf einer geringeren Geschwindigkeit, die für kleine Kreise mit 
dem minimalen Radius gilt, der minimale Radius soll mit der Geschwindigkeit der 
entsprechenden Ausgabe bearbeitet werden. 

Wenn die Höchstgeschwindigkeit übersteigt die Geschwindigkeitsbegrenzung für 
Kreise, gilt diese Geschwindigkeit nur für die Schicht. 

Wenn die Geschwindigkeit auf der Liste steht, stellen Sie die 
Ausgangsgeschwindigkeit gemäß der Liste ein. 

Wenn der begrenzende Schichtparameter eine höhere Geschwindigkeit für die 
Schicht verlangt, wählen Sie die Geschwindigkeit der Ausgabeschicht. 

5> Spiel beim Abtasten 
Beim Abtasten der Grafik mit dem Laser kann die Spannung des Riemens der 

Maschine verursachen, dass die abgetastete Grafik nicht eben ist. Daher muss das Spiel 
geregelt werden. Das Spiel ist mit Geschwindigkeit verbunden. Im Allgemeinen, je höher 
die Geschwindigkeit, desto höher das Spiel. 
1. Spiel erhöhen 

Klicken Sie auf Add (erhöhen) und das folgende Fenster erscheint 

 

Stellen Sie die Geschwindigkeit und das Spiel ein, klicken Sie auf OK, der Wert wird 
der Spielliste hinzugefügt. 
2 Spiel ändern 

Klicken Sie zweimal mit der linken Maustaste auf das Feld Reverse interval (Abstand 
ändern), um den Abstandswert zu ändern, dann erscheint das folgende Fenster. 

 

Hier können Sie die aktuelle Geschwindigkeit des entsprechenden Spiels einstellen. 



 

3 Spiel beseitigen 
Rechtsklicken Sie auf das Feld Reverse interval (Abstand ändern), um den Wert zu 

löschen, dann klicken Sie auf [Delete] (Löschen). 

3.2 Systeminformation 

 

Um die Information über die Hauptplatine und den Hersteller zu sehen, muss man das 
Passwort eingeben. 



 

 

1> Total on time (Gesamtdauer): Die gesamte Arbeitsdauer der Hauptplatine 
2> Total processing time (gesamte Bearbeitungszeit): Die gesamte Bearbeitungszeit mit 

der Springbewegung. 
3> Previous processing time (Zeit der letzten Bearbeitung): Die Zeit der letzten 
Bearbeitung  
4> Total laser on time (gesamte Dauer der Leserarbeit): Die gesamte Dauer der 
Leserarbeit 
5> Total processing times (Anzahl der Bearbeitungen): Die Anzahl der beendeten 

Bearbeitungsvorgänge ohne gezwungene Abschlüsse. 
6> X total travel (Gesamtvorschub X):Der Gesamtvorschub des X-Motors. 
7> Y total travel (Gesamtvorschub Y): Der Gesamtvorschub des Y-Motors  

Version der Hauptplatine: Die Version des aktuellen Steuergerätes. 

Die Aktualisierungsfunktion: 
Wenn die Hauptplatine über zusätzliche Funktionalitäten verfügt, stellen die Hersteller 

eine Bewegungsdatei (*. bin Format) zur Verfügung. Der Benutzer kann dann die 
Bewegungsdatei herunterladen, um die Hauptplatine zu aktualisieren. Nach dem Upgrade 
klicken Sie auf dem Bedienfeld "Reset", um die Hauptplatine zurückzustellen, bevor sie 
normal benutzt werden kann. 



 

 

Die Parameter der Hauptplatine müssen gelesen werden, bevor die 
Benutzerparameter bearbeitet werden können. 

3.3.1 Schnittparameter 

Schnittparameter 
Leerlaufgeschwindigkeit (mm/s) 300.000 
Leerlauf-Beschleunigung (mm/s2) 2000,000 
Startgeschwindigkeit (mm/s) 15,000  
Minimale Beschleunigung (mm/s2) 500,000 
Maximale Beschleunigung (mm/s2) 2000,000 
Schnittmodus Normales Schneiden 
Beschleunigungsmodus  S-Modus 

Leerlaufgeschwindigkeit: Dieser Parameter bestimmt die Höchstgeschwindigkeit aller 
Zeilen, die keine Leserstrahlen während der Bedienung der Maschine emittieren. Dieser 

Parameter soll nicht niedriger sein als  



die Abgangsgeschwindigkeit der X-Achse und der Y-Achse und nicht höher als die 
Höchstgeschwindigkeit der X-Achse und der Y-Achse. Wenn die Einstellung nicht richtig 
ist, stellt das Steuergerät automatisch diesen Parameter im oben genannten Bereich ein; 
eine verhältnismäßig hohe Leerlaufgeschwindigkeit kann die Bearbeitung der ganzen Figur 
verkürzen, aber bei einer übermäßig hohen Leerlaufgeschwindigkeit können die 
Schnittwege schwanken, deswegen sollen Sie bei der Einstellung alle relevanten Faktoren 
berücksichtigen. 

Leerlauf-Beschleunigung: Sie entspricht der Beschleunigung zur 
Luftgeschwindigkeit. Wenn Sie zu niedrig eingestellt wird, mag die tatsächliche 
Geschwindigkeit den eingestellten Wert nicht erreichen, wenn sie zu schnell eingestellt 
wird, können Schwankungen entstehen. Sie soll etwas höher als die allgemeine 
Schnitt-Beschleunigung sein. 

Schnitt-Beschleunigung: Sie entspricht der Beschleunigung zur 
Schnittgeschwindigkeit (Schnittgeschwindigkeit ist die Geschwindigkeit des 
Schichtparameters der Schichten). 

Biegegeschwindigkeit: Eine Verlangsamung beim Biegen während eines 
Schneidevorgangs, die Mindestgeschwindigkeit, wenn die Bearbeitung viele Kurven hat 
und wenn die Bedingungen der Grafik eine reduzierte Geschwindigkeit erfordern. 

Biegegebeschleunigung: Sie soll der Biegegeschwindigkeit entsprechen. 
Schnittmodus: Präzises Schneiden, schnelles Schneiden, sehr schnelles Schneiden, 

Der Benutzer kann ihn je nach der tatsächlichen Anwendung wählen. Ist Genauigkeit am 
wichtigsten, ist die Präzisionsschneiden zu wählen, ist die Geschwindigkeit am wichtigsten, 
ist die Schnellschneiden zu wählen. 

Beschleunigungsmodus: Dieser Parameter bestimmt die Beschleunigung und die 
Verlangsamung (S-Modus oder T-Modus) des Motors bei der Bearbeitung, der Motor 
beschleunigt und verlangsamt langsam und glatt im S-Modus und schnell und 
verhältnismäßig nicht glatt im T-Modus; der standardmäßige Betriebsart ist der S-Modus. 

3.3.2 Durchlaufparameter 

 Durchlaufparameter 
 x 

Startgeschwindigkeit
(mm/s) 

20.000 
 y 

Startgeschwindigkeit
(mm/s) 

15.000 
 x 

Beschleunigung(mm
/s2) 

8000.000 
 y 

Beschleunigung(mm
/s2) 

2000.000 
 Geschwindigkeit des 

Zeilenwechsels (mm, 150.000 
 

Abtastenmodus Allgem. Modus 
 

Größe (50~99%) 98.000 

x-Startgeschwindigkeit, y-Startgeschwindigkeit: Die Geschwindigkeit beim nicht 
aktiven Abtasten mit der Anwendung des Schleppens des Schrittmotors, ohne die 
Beschleunigung von 0, aber von einer Anfangsgeschwindigkeit, damit die Bearbeitungszeit 
reduziert wird. Die Geschwindigkeit ist jedoch nicht zu hoch, und weil die Belastung der X, 
Y-Achsen sich vom Normalwert unterscheidet, ist die Anfangsgeschwindigkeit der X-Achse 
ein bisschen höher als die Anfangsgeschwindigkeit der Y-Achse 

x-Beschleunigung, y-Beschleunigung: Um entsprechende Scangeschwindigkeit 
(der Geschwindigkeit der Schichten im Schichtparameter) zu erreichen, wenn sie zu 
niedrig eingestellt wird, kann nur eine kürzere Strecke bei der Scangeschwindigkeit 
zurückgelegt werden, was die Effizienz des Abtastens senkt. 



Die Maschine kann entsprechend der aktuellen Struktur und der Belastung eingestellt 
werden. Die X, Y-Achsen sind viel höher belastet als der Beschleunigungsmesser der X- 
und Y-Achse. 

Geschwindigkeit des Zeilenwechsels beim Abtasten: Dieser Parameter wird zur 
Kontrolle der Höchstgeschwindigkeit des Abtastens benutzt, um vertikal von einer Zeile in 
die andere zu wechseln. Wenn der Zeilen- oder Blockabstand beim Abtasten zu groß ist 
und eine präzise Positionierung jeder Zeile oder jedes Blocks erforderlich ist, können Sie 
die Geschwindigkeit des Zeilenwechsels beim Abtasten relativ niedrig einstellen. Dieser 
Parameter darf nicht niedriger sein, als die Abgangsgeschwindigkeit der entsprechenden 
Achse beim Zeilenwechsels und nicht höher als die Höchstgeschwindigkeit der 
entsprechenden Achse beim Zeilenwechsels. Wenn die Einstellung falsch ist, passt das 
Steuergerät diesen Parameter automatisch in den oben genannten Bereich ein. 

Abtastenmodus: Es stehen zwei Arten von Scannen zur Wahl: der allgemeine 
Modus und der Sondermodus. Im allgemeinen Modus erfolgt keine Bearbeitung beim 
Abtasten. Im Sondermodus werden Lichtpunkte bearbeitet. Wenn der Sondermodus 
aktiviert wird, soll die Laserleistung erhöht werden, damit die Anzahl der Lichtpunkte 
verringert wird, und die Dämpfung der Laserleistung höher wird. Um dieselbe Scanntiefe zu 
erreichen, muss die Laserleistung höher sein. Der Sondermodus wird benutzt, wenn der 
Laser kurze leistungsstarke Strahlung emittieren soll. Beim Tiefscannen kann man so den 
Effekt des flachen Untergrunds erreichen. Doch wenn die Lichtpunkte falsch geregelt sind, 
kann dieser Effekt nicht erreicht werden und der Modus mit hoher Leistung in kurzer Zeit 
kann die Lebensdauer der Maschine verkürzen. Daher ist der allgemeine Modus 
standardgemäß eingestellt. 

Fakula-Größe: Beim allgemeinen Abtastenmodus ist dieser Parameter deaktiviert. 
Wenn Sie den Sondermodus wählen, wird er aktiviert. Der Parameter soll im Bereich  50% 
bis 99%, liegen. 
3.3.3 Rückkehrparameter 

 Rückkehrparameter 
 Rückkehr-Geschwindigkeit 

(mm/s) 80.000 
 

Automatische Rückkehr X Ja 
 

Automatische Rückkehr Y Ja 
 

Automatische Rückkehr Z Nein 
 

Automatische Rückkehr U Nein 

Rückkehr-Geschwindigkeit: Dieser Parameter verursacht, dass die Maschine zum 
Ausgangspunkt zurückkehrt. Die Rückkehr-Geschwindigkeit darf nicht zu hoch eingestellt 
werden. 

X, Y, Z, U Automatische Rückkehr: Für die Achse kann man einstellen, ob sie zum 
Ausgangspunkt beim Booten zurückkehren soll. 



3.3.4 Bewegungsskala-Parameter  

 Bewegungsskala-Par
ameter   
Bewegungsskala-Mo
dus 

Laser 
abschalten 

 Bewegungsskala des 
Werkstücks (mm) 0.000 

Bewegungsskala-Modus: Lichtpunkte werden am Rand abgeschnitten, am Anfang 
werden die Ränder im 3-Eck-Modus abgeschnitten. 

Bewegungsskala des Werkstücks: Der Umriss für die Bearbeitung kann auf dem 
tatsächlichen Bild basieren. Die Größe kann auch der tatsächlichen Bildgröße entsprechen. 
Damit die ganze Grafik beinhaltet wird, fängt die Bearbeitung links am Rand an. 

Diese Einstellung ist auf dem Bedienfeld zusammen mit den mit dem Rand 
zusammenhängenden Funktionen verfügbar, die Bewegung den Rand entlang ist dagegen 
mit einer gesonderten Software verbunden. 

3.3.5 Sonstige Parameter 

 Sonstige Parameter 
 

 

Reihen-Bearbeitung Matrix mit 2 Richtungen 
 

Ausgangspunkt 
Absoluter 
Ausgangspunkt 

 Verzögerung vor der 
Zuführung (s) 0.000 

 Verzögerung nach der 
Zuführung (ms) 0.000 

 

Fokustiefe (mm) 0.000 
 

X-Spiel(mm) 0.000 
 

Y-Spiel(mm) 0.000 

Reihenmodus: Sie können zwischen dem Schwingmodus und den Einweg-Modus 
wählen. Schwingmodus: die Matrix wird hin und her geschnitten; Einweg-Modus: die Matrix 
wird immer in eine Richtung geschnitten. Wenn der Einweg-Modus gewählt wird, haben alle 
Matrixeinheiten dieselbe Bewegungseigenschaften und dieselbe flüssige Bewegung. Doch 
dieser Modus ist zeitaufwendiger als der Schwingmodus. Die standardmäßige Einstellung 
ist immer der Schwingmodus. 

Rückkehrpunkt: Sie können den Lokalisierungspunkt und der Ausgangspunkt der 
Maschine einstellen. Dieser Parameter bestimmt die Position, den Lokalisierungspunkt 
oder den Ausgangspunkt der Maschine, wo der Laserkopf nach jedem beendeten 
Arbeitsvorgang stoppt. 

Verzögerung vor der Zuführung: Die Benutzer können die Zuführungsvorrichtung 
verwenden und Zeit und andere Parameter, wie den Entnahme-Vorgang bestimmen. 

Verzögerung nach der Zuführung: Bezieht sich auf das Material, das zur 
Zuführungsvorrichtung geschickt wird, die erforderliche Stabilität nach der 
Bearbeitungszeit. 

Fokustiefe: Bedienung des Autofokus, um das entsprechende Feld zu wählen. 
X-, Y-Spiel: Um den durch die Probleme mit dem Antrieb der Maschine verursachtes 

Spiel auszugleichen. 



 

 

1> Read 
Klicken Sie auf Read (Lesen) und die Software wird sich mit dem Steuergerät 

kommunizieren und die Liste der Dateien auf dem Steuergerät wird gelesen. 
Nach dem Lesen des Steuergeräts, erscheinen die Dateiinformationen auf der 

Dokumentenliste.  

2> Download 
Klicken Sie auf Download und ein Datei-bezogenes Dialogfenster erscheint, wo 

herunterzuladenden *rd-Dateien gewählt werden können, dann 



wird die gewählte Datei zum Steuergerät geladen. 
Wird der Download erfolgreich abgeschlossen, wird die Dokumentenliste aktualisiert. 

3> Process 
Wählen Sie die zu bearbeitende Datei aus der Dokumentenliste, und klicken Sie 
auf Process (Bearbeiten). Das Steuergerät wird das gewählte Dokument 
starten. 

4> Delete 
Wählen Sie aus der Dokumentenliste die Datei, die Sie löschen wollen, und klicken Sie 
auf Delete (Löschen). Das Steuergerät wird das gewählte Dokument löschen. 
Nach der erfolgreichen Löschung wird die Dokumentenliste aktualisiert. 

5> Delete All (Alle löschen) 
Automatisch werden alle Dateien im Steuergerät gelöscht und die Dokumentenliste 

wird aktualisiert. 
6> Cal time (Zeitberechnung) 

Die Hauptplatine kann Dateien stundenlang bearbeiten. Wählen Sie die Datei, um die 
Anzahl der Arbeitsstunden zu kalkulieren und klicken Sie auf diese Taste. Die 
Durchführung der Berechnung muss noch auf dem Bedienpanel bestätigt werden. Dann 
zeigen Sie auf die Lesen-Taste auf der Liste, um die Anzahl der Arbeitsstunden zu sehen. 

Zusätzlich wird der kalkulierte Wert nach der Bearbeitung des Dokuments durch die 
tatsächliche Arbeitszeit ersetzt. 



 

Kapitel 4 Laserbearbeitung 

4.1 Gerätsuche 

Wenn nur ein Gerät an den Computer angeschlossen ist, können Sie auf Auto 

umschalten. Die Software wird das Gerät automatisch suchen. 
Wenn mehrere Geräte an den Computer angeschlossen sind, dann müssen Sie 

zuerst auf [ Find com] klicken. 
Nach der Suche erscheinen die angeschlossenen Geräte auf der Aufklappliste. 
Sie müssen jetzt nur das entsprechende Gerät wählen. 

Schichteinstellungen 

Gerätsuche 

Bearbeitungskontrolle 



4.2 Bearbeitung von Schichten 

Zuerst markieren Sie im Menü [Handle] -> [Path optimize] (Weg optimieren) 
“according to layer order” (nach der Reihenfolge der Schichten), dann klicken Sie auf “OK”, 
um zu schließen. 

Reihenfolge der Schichten: Klicken Sie auf Up, Down (oben, unten) – so können Sie 
die Reihenfolge der Schichten ändern, oder ziehen Sie die Schicht in die gewünschte 
Position mit der Maus. 

Hier müssen Sie “Path optimize” (Weg optimieren) markieren. 

4.3 Position 

Die Einstellung des Rückkehrpunktes des Laserkopfes nach der 
Bearbeitung.(Aktuelle Position, Ursprünglicher Anker, Maschine Null.) 
Current Position (Aktuelle Position): Der Laserkopf kehrt in die Position vor der 
Bearbeitung zurück. 

Original anchor (Ursprünglicher Anker): Der Laserkopf kehrt zum letzten Anker 
zurück, der Anker kann auf dem Bedienfeld eingestellt werden. Machine zero 
(Maschine Null): der Laserkopf kehrt zum Null der Maschine zurück. 

4.4 Bewegungsskala, Schnittskala 

In der Bewegungsskala (Go Scale), wie unten gezeigt, ist die tatsächliche Grafik rund 
und das rote Rechteck um den Kreis ist das kleinste Rechteck. Klicken Sie auf Go Scale 
und der Laserkopf geht den rechteckigen Weg entlang. 

In der Schnittskala (Cut Scale), wie unten gezeigt, ist die tatsächliche Grafik rund, und 
das rote Rechteck um den Kreis ist das kleinste Rechteck. Klicken Sie auf Cut Scale, und 
der Laserkopf wird entlang dem rechteckigen Rand schneiden. 

4.5 Start, Pause, Stop, SaveToUFile, UFileOutput, Download Start: 

Übertragen Sie die aktuelle Grafik in die Maschine zur Bearbeitung. 

Pause\Continue (Pause/Weiter): Klicken Sie auf Pause und die Bearbeitung wird 
unterbrochen, klicken Sie auf die Taste nochmals und sie wird fortgesetzt 
Stop (Stopp): Stoppt die aktuelle Bearbeitung 
SaveToUFile (Als U-Datei speichern): 

Speichert die aktuelle Datei im RD-Format, benutzt bei der Offline-Bearbeitung (Kann 
zu einem anderen Speicher zur vollen Offline-Bedienung kopiert werden). 

 



 

UFileOutput (U-Datei-Ausgabe): 
Ausgabe einer Offline-Datei (RD-Format) 
Nach der Speicherung einer Offline-Datei, klicken Sie auf UfileOutput, um eine 

rd-Datei zur Bearbeitung zu wählen. 
Download (Herunterladen): 

Eine Datei kann damit zum Speicher des Steuergeräts heruntergeladen werden, dann 
kann der Benutzer die Datei über das Bedienfeld der Maschine starten. 

4.6 Wahl der Grafik 

Nach der Wahl von Output select graphics (Wahl der Grafik zur Bearbeitung) wird 
nur der gewählte Teil bearbeitet. 

4.7 Optimierung des Weges 

Nach der Wahl von Path Optimize (Weg optimieren), wird der Weg vor der 
Bearbeitung optimiert. 

Wenn die Optimierung des Weges schon durchgeführt wurde und nicht erforderlich 
ist, brauchen Sie Path Optimize nicht zu wählen, denn so können Sie Zeit sparen. 

4.8 Test 

 

Die Achsensteuerung kann die Achsen nur einzeln kontrollieren. Sie können die 
Parameter der Achsenbewegung hier einstellen, darunter die Bewegungslänge, 
Geschwindigkeit, Ein-/Ausschaltung des Lasers und seine Leistung. 

Wenn Sie “Move from origin” (vom Ausgangspunkt starten) wählen, dann ist der 
Abstand, den Sie einstellen, der Abstand vom Maschine Null. 

Wenn Sie diese Option nicht wählen, gilt der Abstand als der Abstand von der 
aktuellen Position. 



Wenn für die X-Achse in der aktuellen Position von 100mm der Schrittabstand auf 
10mm eingestellt wird, dann nach einem Schritt wird die neue Position bei 110mm liegen. 
Wenn die Bewegung vom Ausgangspunkt startet, liegt die neue Position nach einem 
Schritt bei 10mm, und bei einer wiederholten Bewegung ändert sich die Position nicht. 

Hinweis: Nach den Einstellungen des Steuergeräts ist die absolute Position 
kein negativer Wert auf der ganzen Breite. Wenn Sie Move From Origin wählen (vom 
Ausgangspunkt starten), und den Abstandwert negativ einstellen, dann stößt die 
Maschine auf den Begrenzer. 



 

 

4.9.1 Matrix-Einstellung 
Die Einstellung der Matrix-Bearbeitung erleichtert die Bearbeitung der Grafik im 

Matrixverfahren. 
X Num und Y Num (Anzahl), entsprechen den Reihen und Spalten der Matrix  
X Space und Y Space (Abstand), entsprechen den Abständen zwischen den Reihen 

und Spalten der Matrix. 
 

    dient zur Einstellung der Richtung der Matrix. Sie können rechts unten, links unten, 

rechts oben oder links oben wählen. 

4.9 Ausgangseinstellung 



 

Hinweis: Wie oben gezeigt, ist die Position der Grafik im Verhältnis zum Laserkopf 
rechts oben und rechts unten, was zu einer grenzüberschreitenden Grafik führen kann. 

Der Laserkopf steht im Bezug zur Position der einzelnen Grafik, und nicht zur ganzen 
Grafik. In solchem Fall gibt es kein Problem mit der Matrix, wenn ihre Richtung links unten 
ist. 

Zeigt den Abstand der Ränder der Grafiken. 

Zeigt den Abstand der Mittelpunkte zweier Grafiken. 

Regeln Sie die X space, Y space (Abstand) gemäß der Anordnung der Grafik, klicken 
Sie auf dem grafischen Anzeigebereich, damit die Grafiken nicht gewählt werden, dann 
benutzen Sie die Richtungstasten auf der Tastatur, um noch weiter zu regeln, und zoomen 
Sie mit dem Mausrad, damit die Einstellung des Abstands noch genauer wird. Bestrewing 
Breadth Setting(Einstellung der Streubreite): 

Gemäß der Größe des Rahmens und den aktuellen Matrix-Einstellungen stellen Sie die 
maximale Anzahl der Spalten (X Num) und der Reihen (Y Num) ein. 

Klicken Sie auf Bestrewing Breadth, und das folgende Dialogfenster erscheint: 

 

Klicken Sie auf OK. Die Software kann automatisch die richtige Anzahl der Reihen und 
Spalten berechnen. 

 

 

 



[Enable rotate engrave] (Rotation der Gravierung aktivieren): Nach der Aktivierung 
der Gravierung basiert die tatsächliche Präzision der Y-Achse auf dem Durchmesser und 
Schritt per Drehung, um sich automatisch der Einstellung der Impuls-Präzision der Y-Achse 
anzupassen. Der Arbeitsbereich im Hauptinterface wird sich auch ändern. 

[Diameter] (Durchmesser): Der Durchmesser der Teile. 
[Step per rotate] (Schritt pro Drehung): Die Anzahl der Impulse, die einer Drehung 

des Werkstücks entspricht. 
Die Funktion erleichtert dem Benutzer den Wechsel der Teile und Werkstücke 

verschiedener Größe einer ähnlichen Art. Wenn der Unterschied zwischen den Größen des 
Werkstücks ziemlich groß ist, ist es empfohlen, den Schritt des Motors direkt zu ändern. 

Bei der Drehgravierung wird anstelle der Y-Achse die Drehachse benutzt. 

4.9.3 Einstellung der Zuführung 

Um die Zuführung zu benutzen, müssen Sie zuerst diese Funktion aktivieren. 
Nach der Einstellung der Zuführungsparameter wird die Welle eine bestimmte 

Zuführungslänge des Materials zuführen, und danach wird der Vorgang wiederholt, bis die 
Anzahl der Vorgänge der Anzahl der Zuführung gleicht. 

Wenn die Maschine über keine Zuführungsvorrichtungen verfügt, wird das 
Zuführungsverbot aktiviert. 

4.9.4 Optimierung des Spielausgleichs 

Wenn in der Maschine ein Spiel entsteht (z.B. Verschieben der Dichtung beim 
Schneiden der Grafik), kann diese Option gewählt werden. 

4.10 Einstellungen der Schichten 

Klicken Sie zweimal auf die Liste in der Schicht, um die Schicht zu edieren und ein 
Dialogfenster der Schichtparameter erscheint. Die Schichtparameter teilen sich in zwei 
Gruppen; die eine sind die allgemeinen Schichtparameter, wie die zwei Arten der 
Bearbeitung der Schichten; diese Parameter sind aktiviert. Die andere Gruppe sind 
besondere Schichtparameter und sie ändern sich mit der Art der Bearbeitung. 

4.9.2 Gravierung rotieren 



 

 

4.10.1 Einstellung der allgemeinen Schichtparameter 

Layer (Schicht): Die Software benutzt Schichten, um zwischen den Parametern der 
Bearbeitung einer Grafik mit verschiedenen Schichten zu unterscheiden. Die 
Scanverfahren, die Anzahl der Bitmaps in derselben Schicht, die gesamte Ausgabe als 
Bild. Wenn Sie die ganze Bitmap abtrennen wollen, kann die Bitmap in verschiedene 
Schichten eingeteilt werden. 

Is Output (Ist-Ausgabe): Es gibt zwei Optionen: Ja und Nein. Wählen Sie Ja, und die 
entsprechende Schicht wird zur Bearbeitung exportiert; Wählen Sie Nein, und die 
entsprechende Schicht wird zur Bearbeitung nicht exportiert. 

 



Speed (Geschwindigkeit): Die Geschwindigkeit der Laserbearbeitung. 
Hinsichtlich der Schnittgeschwindigkeit bietet die Bearbeitung bei einer niedrigeren 

Geschwindigkeit ein besseres Ergebnis – der Schnittweg ist glatter. Je höher die 
Geschwindigkeit, desto schlimmer das Ergebnis der Bearbeitung; 

Beim Abtasten: Je langsamer bei konstanter Energie, desto tiefer das Bild, die Streifen 
werden dicker und die Auflösung wird entsprechend reduziert. Je schneller der 
Scanvorgang bei der gleichen Energie, desto geringer die Tiefe und höher die Verzerrung 
der Details. 

Bei der Punktbearbeitung ist die Geschwindigkeit der Luftbewegung die größte 
Änderung. 

Wenn Sie "default" (standardmäßig) wählen, entspricht die tatsächliche 
Geschwindigkeit der auf dem Bedienfeld eingestellten Geschwindigkeit. 

Is blowing (Blasen): Wenn die Maschine mit einem Lüfter ausgestattet ist und der 
Lüfter aktiviert und „Ja“ gewählt wurde, wird der Lüfter bei der Bearbeitung der Schicht 
betätigt. Wenn der Lüfter nicht aktiviert ist, ist es ohne Bedeutung, ob Sie "Ja" oder "Nein" 
wählen. 

Processing mode (Bearbeitungsmodus): Es bestimmt, wie eine bestimmte Schicht 
bearbeitet wird. 

Wenn Sie eine Vektorschicht (Farbschicht) wählen, gibt es drei Optionen: 
Laserscannen, Laserschneiden und Laserpunkten; 

Wenn Sie die Bitmapschicht (BMP-Schicht) wählen, gibt es nur eine Option: 
Laserscannen. 

Laser1, Laser2: Das Lasersignal des Einweg- oder Doppelweg-Laserausgangs. 
Wenn die Maschine nur einen Laserkopf hat, ist die Option des Doppelweg-Laserausgangs 
ohne Bedeutung. 

Min power, Max power (Mindest-/Höchstleistung): Der Leistungsbereich ist 0-100, was die 
Laserintensität bedeutet. Je höher der Wert, desto stärker der Laser, und je niedriger der 
Wert, desto schwächer der Laser. 

Bei den verschiedenen Bearbeitungsarten ist die Bedeutung unterschiedlich. 
Beim Schneiden wird die eigentliche Leistung der Schnittgeschwindigkeit angepasst. 

Die Geschwindigkeit bei der geringen Energie ist auch gering, und bei einer hohen 
Geschwindigkeit ist die Energie auch hoch, damit die Energie gleichmäßig während des 
ganzen Schneidevorgangs verteilt wird. Daher liegt die Mindestgeschwindigkeit 
entsprechend der Mindestleistung normalerweise bei 0. Aber wenn Sie die 
Mindestgeschwindigkeit gleich der Startgeschwindigkeit einstellen, entspricht die 
Höchstleistung der Schichtgeschwindigkeit. 
Einstellung der richtigen Mindest- und Höchstleistung 

Wenn der Laser während des ganzen Vorgangs zu stark ist, sollen Sie die Mindest- 
und Höchstleistung niedriger einstellen, ansonsten stellen Sie sie höher; 

Wenn der Laser an manchen Stellen während des Vorgangs zu schwach ist, sollen 
Sie die Höchstleistung höher einstellen; 

Wenn der Laser an manchen Stellen während des Vorgangs zu stark ist, sollen Sie die 
Mindestleistung niedriger einstellen. 

Wenn er durchschneidet, kann die Mindest- und Höchstleistung ohne einen 
wesentlichen Unterschied genauso eingestellt werden. 



 

Beim Abtasten, beim allgemeinen Abtasten, müssen die Mindest- und Höchstleistung 
konstant bleiben. Beim Winkelschneiden wird die Mindestleistung auf der Spitze der 
Neigung eingesetzt und die Höchstleistung am deren Fuß. 

Wenn die Mindestleistung bei der höchsten Teilbreite zu niedrig ist, ist die Auflösung 
der Details auch zu niedrig. 

Wenn die Mindestleistung zu hoch ist, ist die Neigung nicht scharf genug markiert. 

Fuß 

Beim Laserpunkten können die Mindest- und Höchstleistung gleich eingestellt 
werden. 

Wenn Sie "default" (standardmäßig) wählen, entspricht die tatsächliche Leistung der 
auf dem Bedienpanel eingestellten Leistung. 

Klicken Sie auf "Advanced" (Fortgeschritten), dann können Sie auch andere 
Schichtparameter einstellen. 

 

Pen Up und Down (Abstandhalter heben und senken): 
Wenn die Maschine einer Hebevorrichtung ausgestattet wurde und verschiedener 

Tischhöhen für die Bearbeitung bedarf, können Sie die Funktion Pen up und down 
benutzen. 

Das ist die Höhe des Tisches für die Bearbeitung, bei der der Laserkopf das 
Werkstück nicht stört. Wenn der Abstandhalter (Pen) nicht bestätigt, dass der Laserkopf 
das Werkstück nicht stört, können Sie die eingestellte Position des Abstandhalters nicht 
weiter heben. 

Spitze 



 

Verfahren: 
1> Enable pen up und down (Abstandhalter heben und senken aktivieren). 
2> Die Position “pen down” (Abstandhalter unten): Stellen Sie manuell mit den Tasten 

auf dem Bedienfeld die Höhe des Tisches für die Bearbeitung der Grafik 
(Bearbeitungsebene) und den Fokus ein. Dann können Sie mit der Taste "read" 
(lesen) die Position pen down einstellen. 

3> Die Position “pen up” (Abstandhalter oben): Stellen Sie manuell mit den Tasten auf 
dem Bedienfeld die Höhe des Tisches ein, bewegen Sie den Laserkopf, um zu 
prüfen, dass er auf der richtigen Höhe über dem Werkstück ist und bewegen Sie 
den Laserkopf mit der Taste auf dem Bedienfeld, um zu prüfen, dass keine 
Störung besteht. Dann klicken Sie auf "read" (lesen) und stellen Sie die Position 
pen up. 

Dot (Punkt): 
Diese Funktion bezieht sich spezifisch auf die Punkt-zeichnenden Werkzeuge zum 

Zeichnen von Mustern, oder für die aus einer dxf-Datei importierten Punkt-Muster. 
Unabhängig von der aktuellen Art der Bearbeitung der Schichten, d.h., ob die aktuelle 
Schicht geschnitten oder gescannt wird, ist die Pixelgrafik des Punkt-auf-Punkt-Modus 
immer Ausgabe. 

Die Geschwindigkeit eines Punktes ist die Geschwindigkeit der Schicht, und die 
Energie eines Punktes ist die Höchstenergie der Schicht. 
Enable laser (Laser aktivieren): 

Wenn die Maschine mit zwei Lasern ausgestattet ist, gibt es unter normalen 
Bedingungen zwei gleichzeitige Ausgaben. 

Benutzer können jedoch die Laser so aktivieren, dass sie bis zum Ende nicht 
Ausgaben sind. 

4.10.1 Laser Scan Parameters Setting 

  



Das linke Dialogfenster dient zur Einstellung der Parameter für Vektorscannen, das 
rechte Dialogfenster – der Parameter für Bitmap-Scannen. 

Das Scannen der Vektordaten unterstützt die nicht Negative Engrave (negative 
Gravierung), Optimized Scan (optimiertes Abtasten), Output direct (direkte Ausgabe). 

Negative engrave (negative Gravierung): Wenn Sie Negative engraving nicht wählen, 
werden die schwarzen Punkte, die quer durch die Bitmap laufen, den Laser widerspiegeln 
und die weißen Punkte, die quer durch die Bitmap laufen, werden es nicht tun. Wenn Sie 
Negative engraving wählen, werden die weißen Punkte, die quer durch die Bitmap laufen, 
den Laser widerspiegeln und die schwarzen Punkte, die quer durch die Bitmap laufen, 
werden es nicht tun. 

Optimized scan (optimiertes Abtasten): Wenn Sie Optimized scan wählen, wird es 
die Benutzereinstellungen des Scanning interval (Scanabstand) automatisch optimieren 
und dadurch auch den Scanergebnis verbessern. Sonst sollte man die Benutzereinstellung 
von Scanning interval wählen. Im Allgemeinen wählt man Optimized scanning. 

Output direct (direkte Ausgabe): Auf einer Graustufen-Bitmap, Graustufen-Grafik für 
die tatsächliche Ausgabe, wo tiefe und nicht tiefe Farbe den Laser widerspiegelt. 

Ramp effect (Rampeneffekt): Wenn Sie Ramp effect wählen, kann es den Umriss der 
gescannten Figur als eine Rampe darstellen, um einen soliden Effekt zu erlangen. 

Overstriking (Überschreiben): Umfasst Un-process (Rückbearbeiten), Intaglio und 
Rilievi. Normalerweise wird Un-process gewählt. 

Scan-Schriftart ist die Schriftart, die ein Teil des Gescannten ist, also der 
Tiefdruck der Schriftart. 

Das Rilievi ist der untere Teil des Gescannten. 
Hinweis: Wählen Sie ramp effect, stellen Sie die Schriftart fettgedruckt und nicht 

bearbeitet ein. Sonst wird das den Rampeneffekt beeinflussen. 

Scan modes (Abtastenmodi): X_unilateralism, X_swing, Y_unilateralism und Y_swing. 
X_unilateralism: Der Laserkopf tastet die Figuren hin und her auf einer Ebene ab, aber der 
Laser wird nur in eine Richtung emittiert. Z.B. der Laserkopf emittiert Laser beim Abtasten 
von rechts nach links, aber bei der Bewegung von links nach rechts wird kein Laser emittiert. 
X_swing (X_Schwung): Der Laserkopf emittiert Laser und scannt Figuren hin und her 
horizontal. 

Y_unilateralism (Y_Einseitig): Der Laserkopf scannt Figuren hin und her vertikal, aber der 
Laser wird nur in eine Richtung emittiert. Z.B. der Laserkopf emittiert den Laser 
beim Scannen von oben nach unten, aber es wird kein Laser beim Scannen von 
unten nach oben emittiert. 

Y_swing (Y_Schwung): Der Laserkopf emittiert Laser und scannt Figuren hin und her 
vertikal. 
Hinweis: Normalerweise wird der Abtastenmodus X_swing gewählt. 

Font intaglio (Tiefdruck der Schriftart): Der Text hat keinen Rand. Nur der Text soll 

gescannt werden:  

Font rilievi (Rilievi der Schriftart): Der Text hat einen Rahmen, der eine zu scannende 

Figur bildet:  



 

Interval (Abstand): Der Abstand zwischen der aktuellen Zeile und der nächsten Zeile, die 
durch den Laserkopf gescannt wird. Je kleiner der Abstand, desto dunkler die gescannten 
Figuren; Sonst sind sie heller. 
Empfehlung: 1. Abstand beim Abtasten unter 0.1mm für die Vektorschicht (Farbschicht) im 
Allgemeinen einstellen. 2. Abstand beim Abtasten über 0.1mm für die Bitmap-Schicht 
(BMP-Schicht) im Allgemeinen einstellen, und dann die Mindest- und die Höchstleistung 
sollen angepasst werden, um den besten Ergebnis zu erreichen. 

4.10.3 Einstellung der Laser-Schnittparameter 

Die Schnittdichtung nicht geschlossen und bei 
der Grafik  scheint es, dass sie geschlossen 
ist. Sie können ausgleichen, indem Sie die 
Dichtung schließen, aber wenn die Dichtung 
falsch liegt, können Sie nicht ausgleichen, Sie 
können das Spiel ausgleichen wie in 4.9.5, 
oder die Benutzerparameter im Backlash 
compensation (Spielausgleich) benutzen. 

Verzögerung der Öffnung 

Verzögerung des Abschlusses 

Wenn sie die Breite der Spalte ausgleichen, können sie den Abstand zwischen der 
Grafik und der tatsächlichen Ausgangsgrafik nach Laserschneiden ausgleichen. 

Es wirkt für eine geschlossene Grafik. 
Direction (Richtung): Der Richtungsausgleich wird wie erforderlich eingestellt, wie 

z.B. beim Schneiden eines Kreises, wenn Sie das Schneiden des Kreises nach unten 
erhalten wollen, sollen Sie den Richtungsausgleich einstellen; Wenn Sie das Loch erhalten 
wollen, sollen Sie den Ausgleich für die Innenrichtung ausgleichen. 

Sew Breite (Nahtbreite): Es ist die Breite des Lasers.  

 



 

 

4.10.4 Einstellung der Leser-Punktparameter  

Die Zeit für das Emittieren des 
Lasers auf einen Punkt während 
des Vorgangs. Je höher der Wert, 
desto dunkler der Punkt; sonst ist 
er heller. 

Die Punktlänge für das Schneiden einer Strichlinie 

Nur ein Punkt in der Mitte 

 

Der Abstand zwischen den Punkten 


